
Computing Progression Map  

 Computer Science   

Year 
group 

Key skills and ‘sticky’ knowledge 
Key 

vocabulary 

Links to curriculum 
drivers 

VOCABULARY DIVERSITY ASPIRATION 
HEALTH AND WELL BEING 

(Including aspirational figures to be studied) 

Year 1 

-Understand what algorithms are; how they are implemented as programs on digital 

devices; and that programs execute by following precise and unambiguous instructions 

-Create and debug simple programs.  

Create a series of instructions and plan a journey for a programmable toy 

• Know and understand that algorithms are sets of instructions  

• Know that an output is the result of an input, e.g. the Bee Bot moved because 

the direction button was pressed 

• Know that algorithms are implemented as programs on digital devices 

• Know that instructions require sequential and precise inputs to achieve a given 

goal 

• Know how to debug (find errors) in given instructions  

• Know how to create a simple program e.g. a sequence of instructions for a Bee 

Bot to perform given tasks, or control an on screen sprite 

Device 

Control 

Input 

Output 

Direction  

Algorithm  

Instruction 

Sequence  

Sprite  

Commands  

 

Aspiration and Diversity 

Florence Nightingale - the first 

person to combine lots of data 

with good ways of presenting 

all those numbers so the 

patterns can be seen. 

 

 
We are treasure hunters@ Using 

programmable toys – Summer 2. 

Year 2 

-Understand what algorithms are; how they are implemented as programs on digital 

devices; and that programs execute by following precise and unambiguous instructions 

-Create and debug simple programs.  

-Use logical reasoning to predict the behaviour of simple programs.  

Understand that algorithms are used on digital devices 

Write a simple program and test it 

Predict what the outcome of a simple program will be (logical reasoning). 

Understand that programs require precise instructions 

• Know how to write clear and precise algorithms for every day tasks 

• Know how to make predictions using logical reasoning for given algorithms  

• Know how to implement simple algorithms on digital devices e.g. Bee Bot, Blue 

Bot, Daisy the Dinosaur App, Scratch Jr App 

• Know how to decompose algorithms into small chunks to find errors and debug 

programs 

• Know how to use logical reasoning to predict the outcome of simple programs 

• Know how to improve and change a sequence of commands using a trial and error 

approach  

Precise  

Logical  

Reasoning  

Digital devices  

Decompose  

Predict  

Logical reasoning  

Trial and error 

Sequence/sequential  

Aspiration and Diversity 

Grace Hopper – pioneered the 

term bug. 

Year 3 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 
-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Write programs that accomplish specific goals 

Navigate  

Sprite  
Foreground  

Background  

Coordinates  

Commands  

Network 

Aspiration and Diversity 

Jeannette Wing - promotes the 
idea of computational thinking 

as the key problem solving skill 

set of computer scientists. 



Design a sequence of instructions, including directional instructions 

• Know how to navigate the Scratch programming environment  

• Know how to create and alter a sprite and background  

• Know how to work with various forms of input to control the sprite (mouse/keys) 

• Know how to change the position of the sprite by using x and y coordinates  

• Know how to design and create programs that accomplish specific goals in Scratch 

(e.g. draw a shape) 

• Know how to decompose tasks into smaller, separate steps to create an algorithm  

• Know how to use repetition in programs by identifying patterns  

• Know how to improve and change a sequence of commands using a trial and error 

approach 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

Understand what computer networks do and how they provide multiple services 

• Know that digital devices accept inputs, create outputs by following a process 

• Know how to classify inputs, processes and outputs 

• Know the similarities and differences between digital and analogue tools 

• Know that computers in school are connected in a network  

• Know why computers are networked 

• Know the difference between the Internet and the World Wide Web (WWW) 

Position  

Year 4 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Give an ‘on-screen’ sprite specific instructions that take them from A to B 

Experiment with variables to control sprites 

Make an accurate prediction and explain why they believe something will happen  

• Know how to write increasingly more precise algorithms for use when programming 

– using repetition   

• Know how to use simple selection using conditional statements ‘If, Then, Else’ in 

programs to make a decision 

• Know how to use a range of outputs (visual/audio) 

• Know how to use logical reasoning to systematically detect and correct errors in 

programs  

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

Understand how information can be shared online  

• Know that servers on the internet are located across the planet  

• Know how networks are physically connected  

• Know what can be shared using the internet 
• Know how websites can be shared on the world wide web 

• Understand how email is sent across the internet in packets  

Precise  

Repetition  

Selection  

Conditional 

Statements 

Visual/audio  

Servers  

Email  

Internet  

Physical  

 

Aspiration and Diversity 

Charles Babbage - A 

mathematician, philosopher, 

inventor and mechanical 

engineer, Babbage originated 

the concept of a digital 

programmable computer. 

Year 5 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

Variables 

Timers 

Counters  

Conditionals  

Aspiration and Diversity 

Tim Berners-Lee - 

Invented World Wide Web. 

With Robert Cailliau, sent first 

https://en.wikipedia.org/wiki/Tim_Berners-Lee
https://en.wikipedia.org/wiki/World_Wide_Web
https://en.wikipedia.org/wiki/Robert_Cailliau


-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Use technology to control an external device 

Develop a program that has specific variables 

Combine sequences of instructions and procedures to turn devices on and off 

• Know how to design and create a game platform incorporating skills learnt    

• Know how to evaluate their own work, and that of peers, identifying errors.  

• Know how to use variables within programs e.g. timers and score counters using 

conditional statements e.g. if the timer reaches 0, the game ends  

• Know how to create programs that control or simulate physical systems (crumble 

boards/Lego Mindstorms) 

• Know how to evaluate, and debug algorithms  

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

-appreciate how search results are selected and ranked 

Understand how search results are selected and ranked 

Identify and know examples of physical computer systems  

• Know how we view web pages on the internet  

• Know how pages are ranked in a search engine and that the quality of results 

can vary  

• Know and name a range of computer networks and how these connect people e.g. 

social media, internet, intranet and cloud services 

• Know that computers can be connected together to form systems  

• Know and recognise the role of computer systems in our lives  

• Know how information is transferred over the internet   

Simulate  

Evaluate  

Social media  

Intranet  

Cloud services  

External  

Platform  

HTTP communication between 

client and server. 

 

Larry Page - along with his co-

founder Sergey Brin, invented 

Google (link to ‘appreciate how 

search results are selected and 

ranked’) 

 

 

Year 6 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Write a program that combines repetition, selection and variables 

Write generic code that can be used across multiple projects 

• Know how to use a range of sequence, selection and repetition commands, 

combined with variables to implement game designs  

• Know how to broadcast messages  

• Know how to write generic code for use across multiple projects 

• Know how to critically evaluate projects, suggesting improvements  

• Know how to decompose code into sections for effective debugging 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

-appreciate how search results are selected and ranked 
Be aware that some search engines may provide misleading information 

• Know how to effectively use a search engine,  

• Know that to ensure information is valid and accurate, cross referencing of 

different sources is necessary  

• Know and understand the need to critically evaluate information  

Broadcast messages  

Generic code  

Critically evaluate  

HTML 

Sources  

Cross reference  

Critically evaluate  

Aspiration and Diversity 

Hedy Lamarr - During WWII 

she co-invented frequency 

hopping: constantly jumping 

from one frequency to another. 

 

Alan Turing - British scientist 
and a pioneer 

in computer science. 

During World War II, he 

developed a machine that 

helped break the German 

Enigma code. 

 

(Both wider links to WW2 topic) 



 

 

 

Digital Literacy 

   

Year 
group 

Key skills and ‘sticky’ knowledge 
Key 

vocabulary 

Links to curriculum 
drivers 

VOCABULARY DIVERSITY ASPIRATION 
HEALTH AND WELL BEING 

(Including aspirational figures to be studied) 

Year 1 

-Recognise common uses of information technology beyond school 

Talk about some of the IT uses in their own home 

• Know a range of uses for information technology beyond school, e.g. a library 

-use technology safely and respectfully, keeping personal information private; identify 

where to go for help and support when they have concerns about content or contact on 

the internet or other online technologies  

Use technology safely 

Keep personal information private 

Use a website safely  

• Know, discuss and understand the individual elements of SMART rules acronym: 

Safe, Meet, Accepting, Reliable, Tell 

• Know that there are people online who could make you feel sad, embarrassed or 

upset, and give examples of when and how to speak to a trusted adult 

• Know how to use the internet, with adult support, to communicate with known 

people and use key words in search engines  

• Know that information posted online can be copied, and begin to know what 

personal information should be kept offline 

• Know and explain that work created digitally belongs to them; it’s their idea, or 

has their name on 

• Know how to safely log out of websites and equipment when tasks are finished   

SMART rules 

Safe, Meet, 

Accepting, Tell 

Information 

technology  

Online 

Trusted adult  

Internet 

Offline  

Digitally  

Log out   

Health and Well Being 

Safer Internet Day 

 

 

Year 2 

-Recognise common uses of information technology beyond school 

Know how technology is used in school and outside of school 

• Know more ways in which information technology is used beyond school, e.g. how 

a supermarket works 

• Know how technology can be connected and help people 
• Know that the internet is a source of information e.g. books, newspapers, tv 

programmes 

• Know which devices at home are connected to the internet 

-use technology safely and respectfully, keeping personal information private; identify 

where to go for help and support when they have concerns about content or contact on 

the internet or other online technologies  

Source of 

information  

Connected  

Appropriate  

Permission  
Identity  

Search engine  

Health and Well Being 

Safer Internet Day 



Know where to go for help if concerned.  

• Know that some websites are more child friendly and appropriate than others 

• Know which search engines are acceptable to use to stay safe  

• Know which websites are safe to use in school, and at home, with permission   

• Know how people’s identity online can be different to their identity in real life, 

and what these differences could be 

• Know examples of ways to communicate online  

• Know examples of bullying behaviour, and what this might look like online, and 

what can be done about this 

• Know and explain rules and guidance for using technology  

• Know how to report unsafe things online 

Year 3 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content  

Use technology respectfully and responsibly 

Know different ways they can get help if concerned 

• Know what is meant by the term identity, how you can represent yourself online 

and ways in which you can change your identity e.g. using an avatar  

• Know and understand the term digital footprint, being able to give positive and 

negative examples  

• Know the need to be careful before sharing things online, and the consequences 

of this 

• Know and understand the term privacy settings, and how these can be applied 

• Know simple strategies for creating and keeping passwords private, and why they 

are important    

• Know that websites/games implement age restrictions to keep users safe 

• Know different examples of technology specific forms of communication e.g. emojis, 

text speech 

• Know and explain the risks of communicating online with people you don’t know 

well 

• Know the difference between knowing someone online, and knowing someone in 

real life 

• Know what bullying is, and explain how this may happen online, explaining 

strategies to stop this from happening 

Digital footprint  

Privacy settings  

Devices  

Implement  

Technology specific  

Emoji 

Strategies  

Health and Well Being 

Safer Internet Day 

Year 4 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content  

Recognise acceptable and unacceptable behaviour using technology 

• Know how online identities can be different to real life identities  

• Know the importance of reflecting on their online behaviour, and the impact this 

can have on their digital footprint, thinking carefully about how content posted 

online might affect how others feel about them (their reputation) 
• Know and understand that the same friendship values apply online as to face to 

face  

• Know strategies for safe and fun experiences in a range of online social 

environments, giving examples of how to be respectful to others online.  

• Know a range of online technologies where bullying might take place, and the 

ways in which this might happen 

Reputation  

Online social 

environments  

Online technologies  

Reliable 

Accurate  

Copyright  

Opinion 
Belief 

Fact  

Password  

Passcode  

Health and Well Being 

Safer Internet Day 



• Know that some information on the internet is protected by copyright, consider who 

has the right to use it, with examples  

• Know that not all sources of information on the internet are reliable/ accurate, 

knowing the difference between opinion, belief and fact 

• Know how technology can distract from other things, identifying times or situations 

where limiting the amount of time of technology might be of use, and strategies 

to support this  

• Know what a strong password is, and explain strategies for keeping personal 

information private in a range of contexts 

Year 5 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content  

-understand the opportunities they (computer networks, incl. internet) offer for 

communication and collaboration 

Understand that children have to make choices when using technology and that not 

everything is true and/or safe 

• Know and explain how online identities can be copied, modified or altered 

• Know, and be familiar with scenarios associated with online risk and danger, and 

what to do about them 

• Know that all online activity can be traced  

• Know how to make positive contributions to online communities, giving examples  

• Know when someone is upset, hurt or angry online, and know strategies to support  

• Know how to block and report abusive content/users on a range of platforms 

• Know and describe helpline services that are there to support , and how they can 

be contacted e.g. Childline 

• Know the difference between online mis-information (accidental) and dis-

information (deliberate)  

• Know what it means to be sceptical, and understand the term hoax  

• Know that not all information found online is honest, accurate or legal, and can 

explain why and how this might happen 

• Know ways in which technology can affect sleep and describe some of the issues, 

knowing strategies, tips or advice to overcome these, to promote healthy sleep 

• Know how to create and use strong and secure passwords 

• Know and explain how many free apps or services may read and share private 

information from devices 

• Know when it is acceptable to use the work of others, giving examples  

• Know how to work collaboratively to create a blog  

Modified 

Scenario  

Risk/danger  

Online communities  

Traced  

Positive contributions  

Platforms 

Abusive 

content/users 

Mis-information 

Dis-information  

Sceptical  

Hoax  

Blog  

Collaboratively  

Health and Well Being 

Safer Internet Day 

Year 6 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content  

-understand the opportunities they (computer networks, incl. internet) offer for 

communication and collaboration 
Be increasingly aware of the potential dangers in using aspects of IT and know when to 

alert someone if feeling uncomfortable 

• Know that not all online information can be trusted  

• Know how to check and identify the reliability of websites  

• Know and understand different ways to collaborate on projects online  

• Know and understand the need to critically evaluate information found online  

Reliability  

Collaborate  

Vlog  

Critically evaluate  

Influence 
Manipulation  

Persuasion  

Inappropriate content  

Plagiarism 

Copyright 

Data protection  

Health and Well Being 

Safer Internet Day 



• Know how and why some people may present opinions as facts, being able to 

define the terms ‘influence’, ‘manipulation’ and ‘persuasion’, and how these might 

be encountered online (advertising, ad targeting) 

• Know how to identify, and flag inappropriate content  

• Know and be aware of the terms: plagiarism, copyright and data protection in 

relation to their own work 

• Know and be able to describe issues online that might make others feel sad, 

worried, uncomfortable, or frightened, giving examples of ways to help both online 

and offline 

• Know why you should keep asking for help until you get the help you need  

• Know how impulsive content and communication online may cause problems  

• Know ways to support others online, demonstrating ways of reporting problems, 

understanding responsibilities for the well being of others  

• Know how to capture bullying content as evidence (screen grabs, profile links) 

• Know how to develop an online reputation which will allow others to form a 

positive opinion  

• Know and describe the common systems that regulate age related content (PEGI, 

BBFC and parental warnings) and describe their purpose 

• Know, assess and action different strategies to limit the impact of technology on 

health (nightshift mode, regular breaks, correct posture, sleep, diet and exercise) 

and explain the importance of self-regulation of the use of technology, with 

strategies 

• Know to use different passwords for a range of online services, and know what to 

do if passwords are lost or stolen 

• Know and explain simple ways to increase privacy on apps, and explain ways in 

which some online content targets people to gain money or information, describing 

strategies to help identify content    

• Work collaboratively to create a piece of work (Google docs/Teams/Vlog) 

Impulsive content  

Screen grabs  

PEGI 

BBFC 

Self regulation  

 

 

 

 

 

 

 

 



 

 

 

 Information Technology 

Year 
group 

Key skills and ‘sticky’ knowledge 
Key 

vocabulary 

Links to curriculum 
drivers 

VOCABULARY DIVERSITY ASPIRATION 
HEALTH AND WELL BEING 

(Including aspirational figures to be studied) 

Year 1 

Use technology purposefully to create, organise, store, manipulate and retrieve digital 

content 

Record sound and video and play back using an ipad 

Create, store and retrieve digital content 

• Know how to safely turn on and off a laptop, computer or other device. 

• Know the different parts of a computer/laptop e.g mouse, keyboard  

• Know where numbers, letters and symbols are located on the keyboard (use of 

Shift key for symbols).  

• Know and input username and password to log onto the device (laptop/computer). 

• Know the use of the Enter key.  

• Know how to locate a specific program (Word, PowerPoint, Internet).  

• Know how to save a document into the correct folder on the server.  

• Know how to open a saved document.  

• Use at least 2 different types of software to present information, e.g. a booklet 

using ‘Book Creator’ app on ipad, inserting images from camera roll and text.  

 
 

Curser 

Mouse 

Keys  

Keyboard 

Upper/lower case 

Username 

Password 

Program  

Word processor  

Document  

File  

Save 

Retrieve 

Health and Wellbeing – 

learning about ways technology 

can be used to communicate 

with people we don’t live with. 

  

Continuous provision -iPads 

always available to access and 

develop independence to record 

learning. 

 

Ebook about vehicles/transport - 

Spring 1 

Create card digitally for Easter 

– Spring 2 

Talking story book – Summer 1 

Year 2 

Use technology purposefully to create, organise, store, manipulate and retrieve digital 

content 

Organise, retrieve and manipulate digital content 

• Know how and when to use caps lock vs shift key for capital letters.  

• Know how to locate the ‘Home’ Tab in Microsoft Office programs.  

• Know how to change the size, font and colour of text. 

• Know how to copy and paste images from the internet.  

• Know how to insert images from a file.  

• Know how to insert a text box.  

• Know how to input information/data to achieve an output – pictogram, bar chart, 
table.  

• Use at least two different types of software to present information.  

Tab 

Insert 

Font  

Text box  

Output 

Data  

Copy  

Paste  

Data  

 

Year 3 
Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

Layout 

Orientation  

Portrait  

PowerPoint based on visit to 

Rand Farm 

 



accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Discern when it is best to use technology and where it adds little or no value 

Use a range of software for similar purposes 

Collect and present information 

• Know how to use the ‘Layout’ tab in Microsoft Word to change the orientation of a 

document.  

• Know how to add, remove and format a slide in Microsoft PowerPoint.  

• Know how to insert pictures alongside text.  

• Know how to manipulate pictures using the ‘Format’ tab to rotate, bring forwards 

and backwards.  

• Know how to copy and paste texts and images 

• Know how to evaluate own and peers work by commenting on its effectiveness 

against given criteria.   

• Know how to input information to create a chosen output – e.g. graph, and insert 

to a document.    

• Use at least two different types of software to present information. 

• Know that information can be imported and exported via external drives e.g. USB 

Use search technologies effectively 

Navigate the web to complete simple searches 

• Know that the internet contains fact, fiction and opinions, and how this can 

affect their reliability.  

• Know a range of safe search options.  

• Know that URL (Uniform Resource Locator) stands for the address of a world wide 

web page 

• Know how to reach a desired web page.  

Landscape  

Format 

Rotate  

Manipulate  

Evaluate  

Effectiveness   

Imported  

Exported  

USB  

Input  

Output  

URL 

Reliability  

 

 

Research on barn owls (Autumn 

1) 

 

Research on volcanoes and 

earthquakes (Summer 1)  

 

 

 

Year 4 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Select and use software to accomplish given goals, e.g. produce and upload a podcast, 

create a PowerPoint and export as a video 

• Know and understand how and why ‘Transitions’ are used when combining multiple 

slides in a PowerPoint presentation.  

• Know where to locate the ‘Transitions’ menu in Microsoft PowerPoint.  

• Know how to choose an appropriate transition for purpose and effect.  

• Know and understand how and why ‘Animations’ are used to manipulate text and 

images within a slide presentation.  

• Know where to locate the ‘Animations’ menu in Microsoft PowerPoint. 

• Know how to choose an appropriate animation for purpose and effect.  

• Know how to evaluate, edit and improve own, peers and published work by 

commenting on its effectiveness against given criteria.   
• Use at least two different types of software to present information. 

Transitions 

Animations  

Appropriate  

Published  

Edit 

Improve  

Manipulate  

Create music online 

 

Ada Lovelace points out that 

once other things, like music, 

are represented by numbers 

computers can be much more 

than just calculators. 

Year 5 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Analyse and evaluate information reaching a conclusion that helps with future projects  

Presentation  

Diverse  

Green screen  

Collaboratively  

Blog 

Green screen space report 

 

Katherine Johnson, Mary 

Jackson and Dorothy Vaughan: 



Know how to work collaboratively on digital projects 

• Know how to choose which presentation program/app would best meet the needs of 

the project.  

• Know how to create more diverse projects e.g. using green screen and animation.  

• Know how to upload a video/image from one location to another.  

• Know how to work collaboratively to create a blog, sharing information and 

personal views.   

 

• Know the difference between a column and a row in a spreadsheet, and 

understand these are made up of cells.  

• Know how to identify and write within a cell 

• Know how to input data by inserting into columns and cells  

• Know how to highlight specific cells to be used to create a chart/graph 

• Know where the ‘Insert’ – ‘Charts’ menu is located and how to create the most 

appropriate chart/graph.  

• Use at least two different types of software to present information. 

Use search technologies effectively 

Understand that not all search results are reliable  

• Know that search results vary in reliability, and to be objective when reviewing 

results.  

Column 

Row 

Cell 

Highlight  

Menu  

Space-Age Computations 

(Science Link) 

 

Year 6 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Present data collected in a variety of ways that makes it easy for others to understand  

• Know how to add: music, hyperlinks and use slideshow tab edit timings to create 

powerful presentations.  

• Choose the most appropriate software for given tasks, with justification.  
• Know what HTML (Hypertext Markup Language) is and recognise HTML tags  

• Know how to create a webpage using HTML 

• Work collaboratively to create a piece of work (Google docs/Teams)  

• Use at least two different types of software to present information. 

Hyperlink  

Software  

Justification  

Vlog  

HTML 

WW2 PowerPoint 

 

EYFS 

Communication and Language: Listening, Attention and Understanding 

Foundation 1 

Links to 
Curriculum 
Drivers 

Language Development Focus 
Diversity – range of books and stories from different cultures, communities, countries with a diverse range of 
characters 



Language 
I think … It is … because … It has … happened because … 
What can you see? Who do you think …? Why do you think this is a …? Why did … happen? 

 After one third of F1 After two thirds of F1 End of F1 Vocabulary 

Understanding 
technology 

I can anticipate actions and sounds 

from an action toy. 

I can operate some IT or mechanical 

toys. 

I can start to identify objects according 

to simple properties. 

I can turn a toy/technological item on 

and off.  

I can show an understanding of remote 

controls. 

 

I can find the right tool for the job. 

I can show an interest in technological 

items. 

I can begin to use some features of the 

iPad. 

I can use a remote control purposefully to 

produce a wanted action. 

Work, power, 

buttons, 

press, iPad, 

battery, 

remote, 

phone, turn, 

on, off, 

camera 

Foundation 2 

Links to 
Curriculum 
Drivers 

Language Development Focus 
Diversity – range of books and stories from different cultures, communities, countries with a diverse range of 
characters 

Language  
I think … because … It is … because … It has … because … happened because … 
Why do you think this is a …? What can you see? Why did … happen? 

 Autumn 1 Autumn 2 Spring 1 Spring 2 Summer 1 Summer 2 Vocabulary 

Understanding 
technology 

I can find the 

right tool for a job. 

I can show an 

interest in 

technological items 

and making them 

work. 

I can take a 

photograph on an 

iPad and review 

it. 

I know that 

technology needs 

power to work. 

I know that there 

are rules when 

using technology. 

I can select and 

use technology for 

a purpose. 

I know that we can use technology to 

find out information. 

I can record a video on an iPad. 

I can input instructions into a piece of 

technology. 

Record, 

video, 

photograph, 

review, 

charge, 

battery, 

power, 

internet, 

safety, rules, 

pop-up, 

instruction 

 


